## Revision History

<table>
<thead>
<tr>
<th>Revised on</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/07/2020</td>
<td>0.1</td>
<td>Baseline</td>
</tr>
<tr>
<td>02/27/2020</td>
<td>0.2</td>
<td>Date Signed and Date Modified</td>
</tr>
<tr>
<td>03/04/2020</td>
<td>0.3</td>
<td>Added Granular Data functionality</td>
</tr>
<tr>
<td>03/11/2020</td>
<td>0.4</td>
<td>Updated date filters and granular data filter</td>
</tr>
<tr>
<td>03/12/2020</td>
<td>1.0</td>
<td>History Information</td>
</tr>
<tr>
<td>05/1/2020</td>
<td>1.1</td>
<td>Share now options</td>
</tr>
<tr>
<td>05/15/2020</td>
<td>1.2</td>
<td>Advance Formatting options</td>
</tr>
<tr>
<td>05/15/2020</td>
<td>1.3</td>
<td>Rename options</td>
</tr>
<tr>
<td>06/9/2020</td>
<td>1.4</td>
<td>Reprompt</td>
</tr>
<tr>
<td>06/16/2020</td>
<td>1.5</td>
<td>Vendor name input- changes to Uppercase</td>
</tr>
<tr>
<td>07/23/2020</td>
<td>1.6</td>
<td>Sorting(To sort a single column or row);Custom Formatting(Adjust the length of the grid, Auto fix); Qualify an Attribute(Values in Red color); Data Refresh</td>
</tr>
<tr>
<td>09/29/2020</td>
<td>1.7 (Go-Live)</td>
<td>Edit Ad hoc reports created from Report Builder mode</td>
</tr>
<tr>
<td>10/22/2020</td>
<td>1.7.1</td>
<td>Added the statement for “Keep report prompted” when creating ad hoc report with Report Builder mode</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>4</td>
</tr>
<tr>
<td>About Ad Hoc Reports</td>
<td>4</td>
</tr>
<tr>
<td>Accessing Ad Hoc Reports</td>
<td>5</td>
</tr>
<tr>
<td>The Data Bank Home Page – Ad Hoc Reports</td>
<td>7</td>
</tr>
<tr>
<td>Creating an Ad Hoc Report</td>
<td>8</td>
</tr>
<tr>
<td>Ad Hoc Report Builder</td>
<td>9</td>
</tr>
<tr>
<td>Examples for building filters in the report builder</td>
<td>16</td>
</tr>
<tr>
<td>Creating a Blank Ad Hoc Report</td>
<td>20</td>
</tr>
<tr>
<td>Design Mode for Ad Hoc Reports</td>
<td>21</td>
</tr>
<tr>
<td>Ad Hoc Report Toolbar</td>
<td>23</td>
</tr>
<tr>
<td>My Reports</td>
<td>24</td>
</tr>
<tr>
<td>Executing Ad Hoc Reports</td>
<td>26</td>
</tr>
<tr>
<td>Add Condition</td>
<td>32</td>
</tr>
<tr>
<td>Share Report</td>
<td>33</td>
</tr>
<tr>
<td>Print Report</td>
<td>35</td>
</tr>
<tr>
<td>Send Now (Emailing)</td>
<td>37</td>
</tr>
<tr>
<td>Schedule Delivery (subscribe) to History List</td>
<td>39</td>
</tr>
<tr>
<td>Export</td>
<td>40</td>
</tr>
<tr>
<td>Sorting</td>
<td>41</td>
</tr>
<tr>
<td>PDF Export</td>
<td>57</td>
</tr>
<tr>
<td>Show Totals Functionality</td>
<td>45</td>
</tr>
<tr>
<td>Data Refresh</td>
<td>46</td>
</tr>
<tr>
<td>History List</td>
<td>47</td>
</tr>
<tr>
<td>My Subscriptions</td>
<td>48</td>
</tr>
</tbody>
</table>
Overview

The purpose of this document is to provide guidance for the Contract Data (formerly FPDS) ad hoc reports.

User Guides for other types of reports are provided as separate documents.

The Contract Data (FPDS) reports include 4 groups below:

1. Standard reports
2. Administrative reports
3. Static Reports
4. Ad Hoc Reports

The corresponding videos, help files, etc. are located (or will be located) in the Learning Center of beta.SAM.gov. Contract Data is the domain for FPDS (Federal Procurement Data System) information.

About Ad Hoc Reports

The ad hoc reports feature offers the ability to select individual fields from the database to run a query. Ad hoc reports are an advanced feature recommended for users who are familiar with the data fields and knowledgeable on using the sophisticated reporting tool.

At this time the fully functional ad hoc reports are available only for the Contract Data domain.

Registration: Users must register (sign up) for a beta.SAM.gov account to access the Contract Data (FPDS) ad hoc reports.

Data Access: Data access for ad hoc reports is controlled based on your profile information, such as Federal Department or agency role. Non-DoD users are subject to a 90-day delay for DoD-funded awards.

Report Date Range & Data Size Limitation: After the user executes the report, if the report returns a large data set, there is a 12-year or 150,000-row limit of the report records to ensure acceptable system performance. This Data Size Limitation is increased from 30,000 rows in the FPDS system.
How long does a Scheduled Report stay in the History List: Any Scheduled Report that stays in the History List has a message lifetime of 7 days.

Limitations on how many reports can be saved in the History List:
The message lifetime ensures that no History List messages reside in the system indefinitely. If the user logs out of the system when the messages are checked, and if they are older than the lifetime configured here, the messages will be deleted.

Currently, each user can keep up to 500 messages in their History List.

In the History List, if the status of the report shows as “Ready” in bold, it means the report is unread.

If the report status shows as “Ready [mark as "unread"],” it means the report is read.

Accessing Ad Hoc Reports

1. Navigate to: https://beta.sam.gov
2. Click on the **Sign in** link

3. Click Accept to accept U.S. Government System terms.

4. You will be navigated to Login.gov for authentication. Create an account or sign in if you already have one.
4. After login, navigate to the Data Bank page by clicking the hamburger menu, then click on the Data Bank icon.

The Data Bank Home Page — Ad Hoc Reports

Navigate to the Contract Data ad hoc reports page by selecting the domain of Contract Data and then the Ad Hoc report type in the left menu.

Click on Award/IDV Information or Other Transaction Information links to proceed to ad hoc reports with the corresponding award/transaction types.
Creating an Ad Hoc Report

Ad hoc reports are built using MicroStrategy, a business intelligence tool customized to work with Contract Data (FPDS).

**Page Time-Out**: Please note that the ad hoc reports pages are designed to maintain a user session for 12 minutes of inactivity and will log the user out after that. The logout screen does not automatically appear upon the logout, but is displayed after the user starts interacting with the system again.

The left menu is collapsible and contains the following items:
My Reports page is the default landing page for ad hoc reports. It contains a list of your ad hoc reports.

History List page displays all reports that have been executed based on your subscriptions. See the History List section of this document for more information.

My Subscriptions page displays all shared links and a list of subscriptions to the History List. See the My Subscriptions section of this document for more information.

There are two options to get started:
1. Build a Blank Report
2. Build a report using the Report Builder

Both options provide the same capability. The Report Builder is a wizard, while the Blank Report option gives you full control when building the report.

Once you create and save an ad hoc report, it will appear on the My Reports page.

Click on the Create button, then click on the New Report menu option to access these two options.

---

Ad Hoc Report Builder

This section provides an overview of the tool used to create ad hoc reports.

Follow these steps to create an ad hoc report using the Report Builder:
1. Select the Date Range for Date Signed
   a. Specify Start Date for Date Signed
   b. Specify End Date for Date Signed

2. Select the Date Range for Last Modified Date
   a. Specify Start Date for Last Modified Date
   b. Specify End Date for Last Modified Date

All users will have to provide at least one of the date ranges as indicated above. Neither date range cannot exceed 12 years for each. Furthermore, these date range prompts cannot be deleted from the reports. This constraint is applicable to reports created by both Blank Report and Report Builder. The user can use the Reprompt option to change the date range selections. Please note that the report has to be saved before the selections can be changed.

3. Choose the attributes of the report
   a. Click on the available attribute groups to open the list of available attributes. Note that FOUO attributes are available only to government users.
   b. Click on the attribute to select it. Selected attributes are displayed on the right side of the screen.
   c. Click on the “Look In” dropdown to access attributes from other attribute groups, or choose the attribute groups from the Available panel directly.

4. Choose the metrics for the report
   a. Select a metric from the list of available metrics and click on it.

   Note: Action Obligation from FPDS.gov has been renamed to Dollars Obligated. This was done for consistency with standard reports, as it is called Dollars Obligated there.
5. Specify attribute filtering for your report: “Qualify on any attribute.”
   a. Select an attribute group to view the list of available attributes. Click on the attribute to add it as a filter.
   b. Expand the menu next to an attribute to view values available under it for filtering. Click on the value to add it as a filter.
   c. If the value is in red color, you can click on it to enter the value.
d. Once the attribute or value is selected, you can click on any element highlighted in blue to specify additional filtering criteria.

e. Some attributes will be displayed with a lock icon. This means that the attribute has too many values to be displayed in this list.
   a. For each metric, you can select to filter at the report level or the granular level. Granular filtering means that the filter will be applied prior to aggregating values. Regular filtering means that the filter will be applied to metric values that are displayed in the report.
   When selecting a metric for qualification, select an operator from the list as displayed on the screenshot below.

   b. For most cases we recommend using the default level. The default level will qualify on the level of the metric that was selected.
   Other options include:
   - Metric: filtering will take place inside the metric definition. The report filter will be applied first, and the conditional metric filter will be applied after that.
   - Report: filtering will take place at the level at which the report is generated. The conditional metric filter will be applied first, and the report filter will be applied after that.
   - Attribute: filtering will disregard the level of the metric selected in the box on the left and will take place at the level of the attribute selected. To select an attribute level, click on “choose attributes…” at the bottom of the dropdown list as displayed in the screenshots below.
How to apply filter to granular data before data is aggregated:

- Select a metric and set the value for the metric filter.
- Search for “Granular” or select “Granular” under “Granular Level” folder in an attribute level filter as displayed on the screenshot below.
7. Specify a name for your new report and click **Save** on the bottom left corner of the screen to save the report.

8. Save your new ad hoc report.

The **Save As** dialog will appear after you click **Save**. You can provide a name and a description for your new report.

The checkbox of “Keep report prompted” is checked as default, it allows users to make changes when running the reports. If you **uncheck** the checkbox of “Keep report prompted,” users can run the report, but they cannot see the report builder template to make changes of the attributes and/or filters.

**Please Note:**

- You can choose to save the report as a prompted or a non-prompted report:
○ To save it as a prompted report, select the “Keep report prompted” check box. The report is saved with active prompts. When you execute the report in the future, you are prompted for answers again.

○ To save it as a non-prompted report, clear the “Keep report prompted” check box. The report is saved with the currently report prompt values and filter information. When you execute the report in the future, you are not prompted again.

● If you save it as a prompted report, you can change the saved prompt answers when you run the report again, as described below:

○ To save the current prompt answers as the default prompt answers, click Advanced Options. Select the Set the current prompt answers to be the default prompt answers checkbox. When you run the report again, the prompt answers that you selected are displayed as the default prompt answers. You can choose to use the default answers or change them.

○ To use the default prompt answers defined in the prompt, click Advanced Options. Clear the “Set the current prompt answers to be the default prompt answers” checkbox. The prompt answers that you selected are not saved with the report. When you run the report again, the default prompt answers defined in the prompt are not displayed. You can choose to use the default answers or change them. If default prompt answers have not been defined in the prompt, no default answers are displayed.

● The “Only filter will be prompted” option means that users will be allowed to specify different filter values when running the report.

● The “Only template will be prompted” option means that you will be able to change values for additional elements.
9. Click the **OK** button to finish saving your report.
10. A success confirmation message will be displayed to you with an option to run the newly saved report.

**Recommendation:** we recommend users to leave the checkbox of “Keep report prompted.” checked, which you can make the changes when running an ad hoc report. Otherwise, you won’t be able to make changes on this report if you uncheck this checkbox.
Examples for building filters in the report builder

**Example:** Create a filter to show records with Department ID that equals 9700 or 4700.

a. Find Department ID in the list of attributes, and double click on it or click on the “>” button.

b. Click on “Form” as displayed in the screenshot below and select “ID” from the list.

c. Click on “Equals” and select “In” from the list.
d. Click on “Value”, enter “9700;4700” and click on the OK button. 9700 is a parameter that the user can enter for Department ID.

Example: Create a filter to show only records with Modification ID = 0.

a. Find Modification Number in the list of attributes, double click on it or click on the “>” button.
b. Click on the “Form” and select ID.

c. Click on Equals and select Equals for this example.

d. Click on Value and enter “0.”

e. Click on the “OK” button. Your filter is now complete.

f. When users enter the vendor name in upper or lower case, the system will turn the lower case character(s) to upper case.
Making Changes to a Saved Report (When a report is saved using Report builder wizard)

When a report is created and saved using Report builder wizard, in order to alter the report, the user has to Run the report to access the Report builder wizard which let the user make any changes from the report template.

We have two ways to make changes to the report which is created by using Report builder.

Option 1:
- Go to My Reports and select one report
- Click on Run

Option 2:
- Double click on the report name to run this report
These 2 options will bring the user to the Report Builder template so the user has the chance to make changes.

In case user uses the “Edit” function, such as:
The user can right clicking on the ad hoc report name, to see the “Edit” button from the dropdown:

Or, user can look for the “Edit in Design Mode” icon:

User can look for the “Run Report” icon at the top left, click on it to run the report:
No matter which way the user chooses, the idea is that the user must run the report, which will bring up the Report Builder template so the user can make changes and save the report.

Creating a Blank Ad Hoc Report

1. Enter date ranges for Date Signed and/or Last Modified Date for the report. 
   **Note:** Reports can include up to 12 years of data. Dates that the user enters on this page will become required in the report.

2. Click on the **Edit in Design Mode** button on the bottom of the screen.
Design Mode for Ad Hoc Reports

Design Mode can be accessed when working with Blank Reports. Click on the **Edit in Design Mode** button to access Design Mode.

You will be able to access Design Mode only if data has been already provided for all the required fields.
On the left menu, you can select from **Public Objects** or **Schema Objects**. Public objects are metrics; schema objects are attributes.

To build the report, drag or double click on items from the left menu into the rows, columns, and metrics sections.
Click on **Schema Objects** in the left menu; the “Attributes” folder will appear. Click on “Attributes” and select attribute groups, then double click on an attribute to add it to the report. Or, you can drag and drop an attribute to add it.
Click on **Public Objects** in the left menu; the “Metrics” folder will appear. Click on “Metrics” and select metrics that you would like to add to the report.
To navigate between **Public Objects** and **Schema Objects** go back to the Award IDV Information from the drop down as shown below.

To add a filter to a report, you can drag and drop attributes and metrics from the left panel into the filter panel, add the filtering criteria and apply.
To apply a filter to granular data before the data is aggregated:
Select any metric from the “Granular Metrics” folder under Metrics and set the filter.

Granular metrics are evaluated at the granular data level regardless of what attributes are added on the report. By default, metrics are evaluated at the report level — the level of the attributes in the current report.
For example, when you place the Dollars Obligated metric in a report containing an Agency Name attribute, the metric calculates value by an agency. On the contrary, when you place the Dollars Obligated granular metric in a report, the metric calculates the value at the granular data level regardless of which attributes are shown on the report.

Use the dropdown menu above the objects on the left to navigate between attributes and metrics.
Re-Prompting

Whenever a user clicks on the Reprompt button it will ask the user to save any changes that were made to the report.
**Importance of saving a report:**

If user doesn’t save the report after adding new attributes/metrics then message will pop up forcing the user to save the report.

If the user selects **OK** then the user stays on the same page and can save the report.

If the user selects **Cancel** then new changes will not be saved and the user will be on the prompt page.

By default, any unsaved report will have to be saved before the prompts can be changed.
Ad Hoc Report Toolbar

This section provides an overview of the toolbar in the report design mode.

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Report</td>
<td></td>
<td>Run the report. The function will be disabled if the report is not complete.</td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td>Cancel unsaved changes to the report.</td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td>Save report. Opens the save dialog.</td>
</tr>
<tr>
<td>Save As</td>
<td></td>
<td>Save report as. Opens the save dialog.</td>
</tr>
<tr>
<td>Filter</td>
<td></td>
<td>Show/hide filter section.</td>
</tr>
<tr>
<td>Grid</td>
<td></td>
<td>Display “Grid” view (default).</td>
</tr>
<tr>
<td>Graph</td>
<td></td>
<td>Display “Graph” view. Additional graph options become enabled on the right side of the toolbar when this view is selected.</td>
</tr>
<tr>
<td>Grid and Graph</td>
<td></td>
<td>Display “Grid” and “Graph” on one screen.</td>
</tr>
<tr>
<td>Sort</td>
<td></td>
<td>Opens advanced sorting dialog.</td>
</tr>
</tbody>
</table>

Once the report is built, you can either run it or save it using the toolbar at the top of the screen.
Refer to the Executing Ad Hoc report section for guidance on working with executed reports.

**My Reports**

This section provides an overview of the **My Reports** page.

Once you save an ad hoc report, it will appear on the **My Reports** page.

When you hover over the name of the report, you will see the following options:

- Export as PDF
- Export as Excel
- Send now
- Subscriptions
- Edit

The left menu on this page can be collapsed or expanded. When collapsed, icons are displayed instead of labels.
<table>
<thead>
<tr>
<th>Name</th>
<th>Owner</th>
<th>Modified</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Test Plan</td>
<td></td>
<td>9/5/19 11:06:50 AM</td>
<td></td>
</tr>
</tbody>
</table>
Executing Ad Hoc Reports

This section provides an overview of ad hoc report execution.

The screenshot below is an example of an executed ad hoc report:

The following menus are available for an executed report:

NOTE: The Report Home menu provides the ability to switch to Design mode in addition to the options available on the toolbar. (See Toolbar items description below)
The **Tools** menu provides the following options:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New…</td>
<td>Allows you to create a new blank report or a new report using a report builder.</td>
</tr>
<tr>
<td>Report Objects</td>
<td>Opens Report Objects left panel which displays report objects.</td>
</tr>
<tr>
<td>All Objects</td>
<td>Opens All Objects left panel which displays all available objects. These objects can be added to the report by double clicking on them.</td>
</tr>
<tr>
<td>Page-by Axis</td>
<td>When you have a very large set of data on a report, it can be easier to work with that data by grouping it into logical subsets, and viewing only one of the subsets at a time. To group data into subsets, you can use the page-by-feature. This separates</td>
</tr>
</tbody>
</table>
data into subsets called pages, and you then page your way through the report one data subset at a time.

Check the Page-by Axis menu item. Then click on a column in the report and select Move -> To Page-by Axis

**View Filter**
Toggles whether the filter panel at the top of the report is displayed.

**Pivot buttons**
This option enables pivot options for each column of the report:
- Move to columns, move to the left (if applicable), page by this field, and remove from the grid.

**Sort buttons**
Toggles whether sort buttons are displayed for each report column.

**Report bar**
Toggles whether a bar with page and row count is displayed at the top of the report.

The **Data** menu provides the following options:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add View Filter</td>
<td>Toggles display of the filter panel</td>
</tr>
<tr>
<td>Condition...</td>
<td></td>
</tr>
<tr>
<td>Sort</td>
<td>Opens a Sort menu</td>
</tr>
<tr>
<td>Dollars Obligated</td>
<td><strong>$3,774.22</strong></td>
</tr>
<tr>
<td><strong>Drill</strong></td>
<td>Displays a Drill panel at the top of the report</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td><strong>Filter on Selections</strong></td>
<td>You can determine which rows and columns of data are displayed or hidden on a report. For example, if a report has more rows of information than you wish to view, you can specify which rows to hide.</td>
</tr>
<tr>
<td><strong>Hide nulls/zeroes</strong></td>
<td>Hide rows with null/zero metric values</td>
</tr>
<tr>
<td><strong>Reset Data</strong></td>
<td>Reset options applied to the report</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td>Refresh the data displayed in the report</td>
</tr>
<tr>
<td><strong>Re-prompt</strong></td>
<td>Ad hoc reports allow users to run the report again with different prompts without closing the report. Select “Re-Prompt” under the Data menu to access the report prompts again. Click on the Run Report button to run the report with the new prompts.</td>
</tr>
<tr>
<td><strong>Swap rows and columns</strong></td>
<td>Pivot the report so that columns and rows are swapped</td>
</tr>
<tr>
<td><strong>Insert New Metric</strong></td>
<td>This option allows users to add a new metric to the report using the Metric editor.</td>
</tr>
<tr>
<td><strong>Rename</strong></td>
<td>User can rename the column header.</td>
</tr>
<tr>
<td><strong>Show Totals</strong></td>
<td>See “Show Totals” function covered later in this guide.</td>
</tr>
<tr>
<td><strong>Edit Totals</strong></td>
<td>See “Show Totals” function covered later in this guide.</td>
</tr>
</tbody>
</table>
Remove from Grid: The object will be removed from the grid, but remains in the Report Objects pane.

Remove from Report: When a user removes an object from a report, that object is no longer included as part of the calculations for the metrics on the report.

To save your report click on Save or Save As in the Report Home menu.

The Data Menu contains a “Re-prompt” menu item. Use this item to change the prompt answers for the report.
- When blank report template was used, then the user will be navigated to the initial screen where they can change the parameters for Date Signed and Last Modified Date.
When the Report Builder is used, then the user will be navigated to the initial screen where they can change the parameters for Date Signed, Last Modified Date, Attributes, and Metrics.

The Format Menu contains “Advanced Formatting” for Grid, Graph, and resizing of the rows and columns.
### Contract Data (FPDS) Ad Hoc Reports Quick Reference Guide

#### Table

<table>
<thead>
<tr>
<th>Contracting Agency ID</th>
<th>Contracting Agency Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0559</td>
<td>OAG, EXCEPT COURTROLLER GENERAL</td>
</tr>
<tr>
<td>1100</td>
<td>EXECUTIVE OFFICE OF THE PRESIDENT</td>
</tr>
<tr>
<td>1145</td>
<td>PEACE CORPS</td>
</tr>
<tr>
<td>1153</td>
<td>UNITED STATES TRADE AND DEVELOPMENT AGENCY</td>
</tr>
<tr>
<td>1204</td>
<td>OFFICE OF INSPECTOR GENERAL</td>
</tr>
<tr>
<td>1205</td>
<td>USDA, DEPARTMENTAL ADMINISTRATION</td>
</tr>
<tr>
<td>1202</td>
<td>FOREST SERVICE</td>
</tr>
<tr>
<td>1203</td>
<td>NATURAL RESOURCES CONSERVATION SERVICE</td>
</tr>
<tr>
<td>1200</td>
<td>FARM PRODUCTION AND CONSERVATION BUSINESS CENTER</td>
</tr>
<tr>
<td>1202</td>
<td>FARM SERVICE AGENCY</td>
</tr>
<tr>
<td>1203</td>
<td>RURAL HOUSING SERVICE</td>
</tr>
<tr>
<td>1202</td>
<td>FOOD AND NUTRITION SERVICE</td>
</tr>
<tr>
<td>1202</td>
<td>FOOD SAFETY AND INSPECTION SERVICE</td>
</tr>
</tbody>
</table>

#### Format: Template

- **Font**
  - Comic Sans MS
  - Courier New
  - Garamond
  - Haettenschweiler
  - Helvetica

- **Style**
  - Regular
  - Bold
  - Italic
  - Bold Italic

- **Size**
  - 5
  - 6
  - 7
  - 8

- **Effects**
  - Underline
  - Strikeout

- **Color**
  - Black

- **Sample**
  - ABCabc
In the Format dialog box, on the Number tab, you can change the formatting of report numbers.

You can change the width of columns and height of rows.
Sorting:

Sorting a report is one of the ways you can manipulate data display without re-executing the report against the warehouse. You can perform a quick sort, which allows you to sort a single column or row.

Advanced sorting allows you to create your own more advanced sorts for rows, columns, and pages. You can sort by both columns and rows at the same time. You can select the object to sort by, the sorting order (ascending or descending), the sorting criteria, and the position of the totals. The options for the sorting criteria depend on the sort object. For example, the attribute Employee can be sorted by last name, first name, Social Security Number, or the attribute ID. The sorting criteria do not have to be displayed on the report.

To perform an advanced sort:

- Run the desired report.
- From the Data menu, choose Sort.
Select how to sort the report:

- To sort it based on any report object that is in a row, select the **Row** tab.

Select the **Row** tab to specify sort options for the rows of your report. From the first dropdown list, select the name of the first row to sort by, and whether to sort it in ascending or descending order.

For example, you have region and quarter attributes on the report's rows. You can specify that all the region data be sorted in descending order, and then that the quarters should be listed in ascending order.

- To sort it based on any report object that is in a column, select the **Column** tab.

Select the **Column** tab to specify sort options for the columns of your report. From the first drop-down list, select the name of the first column to sort by, and whether to sort it in ascending or descending order.

For example, you have Profit and Region on the report's columns. You can specify that the columns be sorted by the regions in ascending order.

- Click **OK** to view the report with these sorting selections.

Clearing sorts from a report:

You can clear any sorts that have been applied to a given report.

When you have overridden the default sort settings for a report to satisfy an ad hoc need for data display, once that requirement is no longer current you can clear the ad hoc sort settings to return sorting either to its default settings or to different custom ones.

To clear sorts from a report:

1. Run the desired report.
2. From the **Data** menu, select **Advanced Sorting**. The Sorting dialog box opens.
3. On the **Rows** tab, select a sort and click **Remove** to clear the sort settings for that row. Alternatively, to clear the sort settings for all rows, click **Remove All**.
4. Select the **Columns** tab.
5. Select a sort and click \textbf{Remove} to clear sort settings for that column. Alternatively, to clear the sort settings for all columns, click \textbf{Remove All}.

6. Click \textbf{OK} to return to the report.

7. To retain the new sort settings, save the report.

The following items are available in the \textbf{Toolbar} of a report:

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td><img src="image" alt="Undo" /></td>
<td>Undo the last report action</td>
</tr>
<tr>
<td>Redo</td>
<td><img src="image" alt="Redo" /></td>
<td>Redo the last action that was undone</td>
</tr>
<tr>
<td>Grid</td>
<td><img src="image" alt="Grid" /></td>
<td>Displays the report as a grid.</td>
</tr>
<tr>
<td>Graph</td>
<td><img src="image" alt="Graph" /></td>
<td>Displays the report as a graph. MicroStrategy can display data in numerous graph types and styles.</td>
</tr>
<tr>
<td>Grid and Graph</td>
<td><img src="image" alt="Grid and Graph" /></td>
<td>Displays the report in both grid and graph views at the same time on the screen.</td>
</tr>
<tr>
<td>Share</td>
<td><img src="image" alt="Share" /></td>
<td>Shares your report in an email or as a link.</td>
</tr>
<tr>
<td>Print</td>
<td><img src="image" alt="Print" /></td>
<td>Allows you to specify print settings for the report and print the report.</td>
</tr>
<tr>
<td>Send Now</td>
<td><img src="image" alt="Send Now" /></td>
<td>Allows you to email an executed report detail or report link to specific email addresses.</td>
</tr>
<tr>
<td>Schedule Delivery to History List</td>
<td><img src="image" alt="Schedule Delivery to History List" /></td>
<td>Opens the Subscribe to History List dialog box for a user to set up automatic delivery of a report/document to your History List/My Subscription on a specific schedule.</td>
</tr>
<tr>
<td>Export</td>
<td><img src="image" alt="Export" /></td>
<td>Exports all (or a portion) of the report in Excel, CSV, HTML, or plain text format. Does not include the report appendix information.</td>
</tr>
<tr>
<td>PDF</td>
<td><img src="image" alt="PDF" /></td>
<td>Allows users specify settings to convert and display reports in PDF format. The summary appendix information does not show using this toolbar option. Please use the \textbf{PDF Export} button in the Report Criteria Accordion if appendix is needed.</td>
</tr>
</tbody>
</table>
Add Condition

The Add Condition toolbar item allows users to add conditions to the report.

![Add Condition Toolbar]

Filter On: Contractor Name, DUNS Number, Dollars Obligated

<table>
<thead>
<tr>
<th>DUNS Number</th>
<th>Contractor Name</th>
<th>Dollars Obligated</th>
</tr>
</thead>
<tbody>
<tr>
<td>001000363</td>
<td>LOUIS M GERSON CO INC</td>
<td>$279.30</td>
</tr>
<tr>
<td>001004092</td>
<td></td>
<td>$23,250.00</td>
</tr>
<tr>
<td>001004258</td>
<td></td>
<td>$2,501.89</td>
</tr>
<tr>
<td>001004332</td>
<td></td>
<td>$10,550.00</td>
</tr>
</tbody>
</table>
Share Report

The Share Report function allows you to share an ad hoc report as a link and email the link to the report. You can also define which users can see or edit the report.

Note that clicking on Email Link is meant to open up your default email application, a feature that is blocked on some systems. If you have this limitation, the link can be manually copied and pasted from this form into an email.

Click on the button with the clipboard icon to copy a link to share the report to your clipboard.

You must send the link via an email either using the Email Link option or by manually sharing the link with the desired recipients.

You can type the name of the recipient in the text box and press enter to add them to the list as displayed on the screenshot below. For each user that the report is shared with, you can specify their access level.
In addition to entering names, you can click on the **Browse** button to view the list of government users that this report can be shared with.

**View:** Grants permission to access the object for viewing only (Browse, Read, Use, Execute).

**Modify:** Grants permission to view and modify the object (Browse, Read, Use, Execute, Write, Delete).

**Full control:** Grants all permissions for the object and allows the recipient to modify.

**Denied all:** Explicitly denies all permissions for the object.

**Custom:** Allows the user or group to have a custom combination of permissions.

**Note:** Only government users that have run at least one standard, administrative, or ad hoc contract data report will be displayed in this list.
Print Report

The Print functionality allows you to print or download a report by choosing from multiple export options and specifying formatting options.
The following are the steps to use the Print functionality:

1. Select the Print Icon from the Toolbar.

2. Choose one of the two options for what to export:
   a. Whole Report: all results will be exported, up to 150K rows.
   b. Portion displayed only: Use this option to export the rows that are currently displayed in the grid.

3. In the Scaling area, specify how the content will adjust to the printed page. Select one of the following options:
   a. To specify the font size of text displayed on a report as a percentage of its original size, select the Adjust font to % of original size option, then type a percentage in the field. The default is 100%.
   b. To specify the page dimensions in which to fit the report contents, select the Fit to page(s) wide by tall option, then type a number in the fields. The default is 1 page wide by 1 page tall.

4. If you have a graph displayed in the results, the option to choose the graph location is displayed. This option is only displayed when there is a graph in the results.
   a. Select the checkbox for Print the grid and graph on the same page if you do not want to have them on separate pages.

5. In the Orientation area, select Portrait to export the report in a vertical format. Select Landscape if you want the report to print horizontally.

6. To include a page header and footer on the report, click Edit Custom Settings next to Page Header and Footer to open the Header/Footer Editor. You can place text in the left, center, and right portions of the page's header and footer.

7. To specify the text to display in the report header, click Edit Custom Settings next to Report Header to open the Report Header Editor. You can type specific text or use the Insert Auto-text dropdown list at the top of the page to select and insert auto-text.

8. You can choose to include a cover page for the report.
   a. To specify whether the cover page is placed before or after the report, select Before report or After report.

9. To adjust settings such as paper size, margins, and maximum header and footer sizes, click the Show Advanced Options button to open the additional options.
   a. From the Paper size dropdown list, select the paper size for the report. The default is letter (8.5" x 11").
   b. Type the margins you want to use in the report in the Margins (Inches) fields. Set the left, right, top, and bottom margins. For reports to print correctly, these margin settings and the margin settings in the browser's File > Page Setup option must match. The default value for each margin is 0.75 inches.
   c. In the Maximum header size (Inches) field, type the size at which the report header can be overwritten. If the header is larger than its maximum size and the report must use the space to display its content, the header will be cut off by the report content. If the report does not use the space, the entire header is displayed, regardless of size. The default header size is 0.5 inches.
   d. In the Maximum footer size (Inches) field, type the size at which the report footer can be overwritten. If the footer is larger than its maximum size and the
report must use the space to display its content, the footer will be cut off by the report content. If the report does not use the space, the entire footer is displayed, regardless of size. The default footer size is 0.5 inches.

10. To use the predetermined fonts for the report, select the **Embed fonts** check box.

11. Select **Do not prompt me again** checkbox if you do not want to answer these settings in the future when printing a report. (*Not recommended*)

12. Click **Show Printable Version**. The report, using your selected settings, is opened in another browser tab.

13. You can **Download or Print** your report by selecting the appropriate button from the menu.

14. In order to retain custom formatting user has two ways
   a. Adjust the length of the grid: Resize the column width.
   b. Auto fix: Select **Format** option and select **Resize column and Rows**

<table>
<thead>
<tr>
<th>IDV Contracting Office Business Size Selection</th>
<th>IDV Contracting Office Business Size Selection Description</th>
<th>Contracting Office ID</th>
<th>Contracting Department ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>120248</td>
<td>1300</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>120407</td>
<td>1200</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>123151</td>
<td>1200</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>12435K</td>
<td>1200</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>126395</td>
<td>1200</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>12826H</td>
<td>1200</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>12F330</td>
<td>1200</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>12SAD1</td>
<td>1200</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>1305M2</td>
<td>1300</td>
</tr>
<tr>
<td>0</td>
<td>OTHER THAN SMALL BUSINESS</td>
<td>1331L5</td>
<td>1300</td>
</tr>
</tbody>
</table>
And choose the **Fixed** columns option and click on **Export**.

- **Send Now (Emailing)**

  The Send Now functionality allows users to send the data or link of the report they have executed by choosing from multiple delivery options and multiple formats.

  **Note:** If report results are large, the Send Now function is not the best option for providing results to others. Please consider using the Export option in the toolbar. See the Export Reference in this document.

  The following are the steps to use the **Send Now (Email)** functionality:

  1. Select the **Send Now** icon in the Toolbar.
  2. Select the **To** button to select the email(s) from the available registered users or add new email address(es) to send the report to.
  3. **Single click recipient name(s)** from the Available list and **click the appropriate box** (To, Cc, Bcc) **arrow** to select the email address to send the report to.
  4. Once done selecting recipients, **select the OK** button to close the pop-up box.
  5. **Click anywhere in the Send field** to display the options of what will be sent to the recipients.
  6. **Single click** an option in the available dropdown list to select that method.
     a. Data in email: The report results will appear in the email body.
     b. Data in email and to history list: The report results are in the email and the report will be in your user history list.
     c. Data and link to history list in email: The report results and a link to open the report list will appear in the email.
d. Link to history list in email: A link will be in the sent email to open the executed report.  

**Note:** Link to history list and adding data to history list is a snapshot of the data at this time. It does not refresh.

7. Click anywhere in the **Delivery Format** field to display the format options for the data being sent.  
**Single click** an option in the dropdown list to select that format.

![Send Now email form](image)

8. Update the Subject line. (Optional)  
9. Enter a message. (Optional)  
10. If the report is large and you are sending the actual data, Compression and Password protection are available options.  
   a. Click the **Compress contents** box to the right of the Delivery Format to compress the data.  
   b. Click the + to expand the Advanced Options area.  
      i. Click the **Password protect zip file** check box and enter password  
   c. Update the name for the zip file. (Optional)
11. Select the OK button to send the email.
12. A confirmation message will appear under the toolbar and above the grid and will disappear quickly.
Schedule Delivery (Subscribe) to History List

NOTE: Users with an administrator role with scheduling permission, or users without an administrator role but granted scheduling permission, can access the report scheduling function.

Follow these steps to use the Schedule Delivery functionality:

1. Enter the name of the report.
2. Select the desired schedule from dropdown, for example: Daily, Weekly, etc.
3. Enter whom would you like to send the report to.
4. If desired, check the option to run a subscription immediately.
5. Check the box for “Send notification to email address,” then click OK.
6. If you would like to cancel the subscription, click the Cancel button.
Export

The Export function allows you to send the report results by choosing from multiple export options and multiple formats.

Follow these steps to use the Export functionality:

1. Select the Export icon from the Toolbar.
2. Choose one of the two options for what to export:
   a. Whole Report: all returned rows will be exported.
   b. Portion displayed only: Use this option to export the rows that are currently displayed in the grid.
3. Choose one of the formats to export the report results:
   a. Excel with plain text: The report is exported and displayed as a Microsoft Excel spreadsheet, which contains only the text of the grid report. The spreadsheet does not retain the formatting of the report as displayed in the beta.SAM.gov portal.
      i. Excel options:
         1. Export metric values as text: Determine whether numeric values should be exported as text or as numbers. If you choose to export metric values as numbers, Excel may automatically format the number. For example, $34,236.14 may be rounded to $34.24 in Excel. If you choose to export metric values as text, Excel will not automatically format the numbers. This setting only applies to exports to Excel. This check box is cleared by default.
         2. Export headers as text: Determine whether header values should be exported as text or in their current format, which could be numeric, date, and so on. This setting only applies to exports to Excel. This check box is cleared by default.
   b. CSV file format: The report is exported as a CSV file. The contents of the grid report are displayed, separated by commas. (Default option)
c. **Excel with formatting:** The report is exported and displayed as a Microsoft Excel spreadsheet. The spreadsheet retains the formatting of the report as displayed in beta.SAM.gov Portal, such as colors, fonts, and structure.
   
i. **Excel with Formatting Option:**
   1. **Embed all images:** Determine whether exported graphs and images from the report are included in the Excel spreadsheet as images. If this check box is selected, the images and graphs can be accessed from the spreadsheet. This check box is selected by default.

d. **HTML:** The grid report is exported to an HTML file.

e. **Plain text:** The contents of the grid report are exported to plain text, and the [Delimiter](#) you specify separates data from each cell of the report.
   
i. Choose one of the five (5) available options for the delimiter:
   1. Comma (Default option)
   2. Tab
   3. Semicolon
   4. Space
   5. Tilde

f. **Note:** Only the Excel with formatting and HTML options are available when exporting both the grid and the graph.

4. Select **Export Report Title** to see the title on the exported report.

5. Optionally, select **Export filter details** to see the report criteria that you entered. If you choose to export them, they appear above the exported report.

6. Select the option to use for **Remove extra column** Determine whether the column that displays the word **Metrics** is displayed on the exported report.
   Metrics are the calculations performed on data, the results of which are displayed on a report. Metrics are similar to formulas in spreadsheet software. The Metrics column is designed to distinguish a metric (calculated field) from an attribute.
   
a. **Yes:** The word "Metrics" is removed and not displayed.
   b. **No:** The word "Metrics" is not removed and is displayed.
   c. **Automatic (default):** The report-level setting is applied. The beta.SAM.gov report-level setting is Yes (the word “Metrics” is not displayed).
7. **Select Edit Custom Settings** to specify Header and Footer details. Type text in the Header and Footer fields or select auto-text to insert from the Insert Auto-text dropdown list.

8. Select the **Do not prompt me again** checkbox if you do not want to answer these settings in the future when exporting a report. *(Not recommended)*

9. Select the **Export** button to export your report with the values selected.

10. The export will be available in your download folder.
PDF Export

The PDF export functionality allows you to download a PDF version of a report by choosing from multiple export options and specifying formatting options.

Follow these steps to use the PDF export functionality:

1. Select the PDF icon from the Toolbar.
2. Choose one of the two options for what to export:
   a. Whole Report: all returned rows will be exported.
   b. Portion displayed only: Use this option to export the rows that are currently displayed in the grid.
3. In the Scaling area, specify how the content is adjusted to the PDF page. Select one of the following options:
   a. To specify the font size of text displayed on a report as a percentage of its original size, select the **Adjust font to % of original size** option, then type a percentage in the field. The default is 100%.
b. To specify the page dimensions in which to fit the report contents, select the **Fit to page(s) wide by tall** option, then type a number in the fields. The default is 1 page wide by 1 page tall.

4. If you have a graph displayed in the results, the option to choose the graph location is displayed. If no graph is in the results, this option is not displayed.
   a. Select **Print the grid and graph on the same page** if you do not want to have them on separate pages.

5. In the **Orientation** area, select **Portrait** to export the report in a vertical format. Select **Landscape** if you want the report to print horizontally.

6. To specify the page header and footer to be displayed on the report, click **Edit Custom Settings** next to **Page Header and Footer** to open the Header/Footer Editor. You can specify the text to place in the left, center, and right portions of the page's header and footer. Type static text or use the **Insert Auto-text** dropdown list at the top of the page to select and insert auto-text.

7. To specify the text to display in the report header, click **Edit Custom Settings** next to **Report Header** to open the Report Header Editor. You can type static text in the **Header** field or use the **Insert Auto-text** dropdown list at the top of the page to select and insert auto-text.

8. You can choose to include a cover page for the report by selecting **Print cover page** checkbox.
   a. Select whether the cover page will include **Filter Details** or **Report Details**.
   b. To specify whether the cover page is placed before or after the report, select **Before report** or **After report**.

9. To adjust settings such as paper size, margins, and maximum header and footer sizes, click the **Show Advanced Options button** to open the additional options.
   a. From the **Paper size** dropdown list, select the paper size to use to export the report. The default is letter (8.5" x 11").
   b. Type the margins you want to use in the report in the **Margins (Inches)** fields. Set the left, right, top, and bottom margins. For reports to print correctly, these margin settings and the margin settings in the browser’s File > Page Setup option must match. The default value for each margin is 0.75 inches.
   c. In the **Maximum header size (Inches)** field, type the size at which the report header can be overwritten. If the header is larger than its maximum size and the report must use the space to display its content, the header will be cut off by the report content. If the report does not use the space, the entire header is displayed, regardless of size. The default header size is 0.5 inches.
   d. In the **Maximum footer size (Inches)** field, type the size at which the report footer can be overwritten. If the footer is larger than its maximum size and the report must use the space to display its content, the footer will be cut off by the report content. If the report does not use the space, the entire footer is displayed, regardless of size. The default footer size is 0.5 inches.

10. To use the predetermined fonts for the export file, select the **Embed fonts** check box.

11. Click **Export**. The report is exported in the selected form.
Show Totals Functionality

Select **Show Totals** under the **Data** menu for the report to display totals for all numeric fields in the report, grouped by all other report fields. An example is displayed on the image below.

![Image of Show Totals functionality](image)

Click on the **Show Totals** menu item again to hide the totals from the report.

The **Edit Totals** option under the **Data** menu provides additional features for displaying totals, such as removing unneeded subtotals, as seen in the screenshot below.
Data Refresh

- Adhoc reports: Every day Data refresh will be completed by 6.30

History List

This section provides an overview of the History List section of ad hoc reports.

Schedule Delivery (subscribe) to History List for reports to appear in this list. Every time the report is scheduled to run, a row will be added to this list.

Click on an item in this list to view a report that has already been generated for you.

You have an option to export the report to Excel or PDF, view subscription details, rename, or remove the report subscription.
My Subscriptions

This section provides an overview of the My Subscriptions section of ad hoc reports.

The My Subscriptions page has two sections:

- Shared links
- History List Subscriptions

Shared Links displays all instances of when you shared an ad hoc report link with other users. Users who received the link have to save the report for it to display in My Reports.

History List Subscriptions displays all history list subscriptions that you have. Reports generated under these subscriptions will be displayed in the History List page.